What's New in this Release
Scorpio includes new features and enhancements in the following product areas:
■

Interaction with other technologies and Adobe products

■

Administration and Configuration

■

Debugging

■

Language Enhancements

■

Arithmetic and string operations

■

Database access

■

Generating reports and presentations

■

OEM support
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Interaction with other technologies and Adobe products
Feature/Tag

Description

AJAX UI support

Several new features have been added that take advantage of AJAX capabilities.
The following new tags let you control the layout and behavior of your application:
• The cflayout tag can create four types of layout regions.
• The cflayoutarea tag defines the regions contained inside a layout created by a
cflayout tag.
• The cfwindow tag creates a pop-up window in the browser that you can
programmatically show and hide.
• The cfpod tag creates a region with an optional title bar.
• The cfmenu tag creates a horizontal or vertical menu with optional submenus.
• The cfmenuitem tag creates an entry in a menu. A menu item can be the root of a
submenu.
• The cftooltip tag lets you specify an optionally HTML-formatted tool tip that
appears when the user moves the mouse pointer over the items defined by any
tags in the cftooltip tag body.
The cfgrid tag now has an html attribute value of AJAX that creates a dynamic
HTML grid. The grid can optionally use a bind expression (see below) to dynamically
fill and update the grid contents. The grid can optionally be divided into pages with
each page contents retrieved from the server when the user requests the specific
page, thereby improving initial load time.
The cfgrid tag has added the bindOnLoad, onChange Refresh, and presevePageOnSort
attributes:
The cflayout tag has a new tabheight attribute, used when type=”tab”.
The cftree tag now has a format attribute value of html that creates a dynamic
HTML tree. The tree can optionally use a bind expression (see below) to dynamically
fill and update the tree contents. Tree contents can optionally be retrieved from the
server when the user opens tree branches, thereby improving initial load time.
The HTML format cfinput tag now supports a datefield type that lets users select
dates from a pop-up calendar.
The HTML format cftextarea tag now supports a richtext attribute that creates a
rich text editor that lets users easily insert rich HTML-formatted text. The editor has
a developer-configurable toolbar with formatting commands that includes support
for templates, custom styles, and several other features.
You can now control the values of certain control attributes dynamically by using
bind expressions and bind parameters. A bind parameter gets data from another
form control attribute value and is updated every time a particular JavaScript event
happens. A bind expression optionally uses the bind parameter to set a value
dynamically.
• The cflayout, cfpod, and cfwindow tags let you use URLs to set the value of their
contents.
• The cfinput, cfselect, and cftextarea tags let you use CFCs or JavaScript
functions in bind expressions to set the value of their contents.
• The cftree cftreeitem, and cfgrid tags let you use CFCs or JavaScript functions
in bind expressions to fill the tree and grid contents.
• The cfinput tag with a text type attribute lets you use a CFC bind expression to
generate a suggestion drop-down list based on initial user input. After typing some
characters, a user can select a suggested value from the list.
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Feature/Tag

Description
The cfselect and cftextarea tags have added an onBindError attribute.
The following features have also been added:
• You can now use the tooltip attribute in HTML format versions of the cfinput,
cfselect, and cftextarea tags. The tags can specify a URL as the source for the
tool tip contents.
• A loading icon, and in some cases a "Loading...." text string, appears when a tag
that uses a bind expression is loading the bound contents.
• A QueryConvertForGrid function has been added that converts a ColdFusion
query into a paged data format that can be returned by a CFC to an AJAX format
cfgrid tag to fill the grid contents.
Function signatures in JavaScript included dynamically through a source attribute
must follow the format:
<functionName> = function(<arguments>) {<function body>}
The commonly adopted approach below may not work:function <functionName>
(<arguments>) {<function body>)

There is now URL bind support for data-bearing AJAX controls. This means that
CFM files (rather than CFCs) can populate data for trees, grids, and so on.
The cfinput, cfpod, cfwindow, cflayout, cfsprydataset, and cftreeitem tags now
include an onBindError attribute to allow specification of a JavaScript error handler
for normal and autosuggest binds.
There is a new ColdFusion.Ajax.submitForm function.
There is a new ColdFusion.Grid.sort JavaScript function.
There is a new AjaxOnLoad function.
There is a new cfdiv tag.
The source attribute of the cfdiv tag has been renamed to bind. Values of the bind
attribute now include all kinds of binds, including simple, JavaScript, URL, and CFC.
For more information, see the tags listed above in CFML Reference.
AJAX application support

The new cfajaxproxy tag creates a JavaScript proxy for a ColdFusion component
that you can then use in AJAX client code. The proxy and ColdFusion server-side
support simplify the creation of AJAX applications that use CFCs by managing the
interactions between the client and server. Features include providing JavaScript
functions that correspond to the CFC functions and automatically serializing CFC
return values into JSON format. AJAX support also includes three CFML functions:
SerializeJSON, DeSerializeJSON, and IsJSON, that manage JSON data.
For more information, see CFML Reference.
There is now setForm support for JavaScript proxies generated by the cfajaxproxy
tag.
The cfajaximport tag now has a scriptsrc attribute.
The cfajaximport tag now has a csssrc attribute.
The serializeJSON function now has a serializeQueryByColumns attribute.
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Feature/Tag

Description

AJAX Application Generation
wizard

The AJAX Application Generation wizard is available as an Eclipse plugin. To install
it, install the ColdFusion Plugins for Eclipse.
To run the wizard, in Eclipse:
1. Select File > New > Other.
2. Under ColdFusion Wizards, select ColdFusion/AJAX Application Wizard, and
then click Next.
3. After reading the introductory text, click Next.
4. Select the project whose settings you want to use or, if this is the first time you are
running the wizard, click Next.
5. Specify the RDS server on which you want the application to reside.
6. Specify the data source to use, and then click Next.
The wizard works similarly to the ColdFusion/Flex Application wizard. For
information about that wizard, see ColdFusion Developer’s Guide.

JSON-related functions

There are three new CFML functions: SerializeJSON, DeSerializeJSON, and IsJSON,
that manage JSON data.
For more information, see CFML Reference.
The deserializeJSON function has a new strictMapping argument.

.Net assembly support

You can access .NET assembly classes as ColdFusion objects by specifying
type=".Net" in the cfobject tag or the createObject function. You can then use
ColdFusion code to instantiate the class and call its methods and read and write its
fields. The .NET support uses Java proxies to represent the .NET classes on the
ColdFusion system, and requires that a .NET-side agent run on the system where
the assemblies are located.
For more information, see ColdFusion Developer’s Guide.
The createObject function and cfobject tag now support both “dotnet” and ".Net"
as values for the type attribute.
There is now a DotNetToCFType(variable) function. It converts a complex DotNet
type variable to a ColdFusion array, structure, or query, depending on the type.

Support for reading and
creating Atom and RSS feeds

The new cffeed tag can read RSS and Atom feeds in all commonly-used formats,
and can create RSS 2.0 and Atom 1.0 feeds. The feed information can be
represented in structure format or in a combination of structure and query formats.
The tag also can save feed XML in a variable or file.
For more information, see CFML Reference.

Ability to manipulate existing
PDF documents by using the
new cfpdf and cfpdfparam tags

The new cfpdf tag lets you manipulate existing PDF documents. ColdFusion also
provides a subset of Adobe® LiveCycle™ Assembler functionality via the processddx
action of the cfpdf tag
Use the cfpdfparam tag with the cfpdf tag to merge several PDF documents into one
document, or merge pages and page ranges from multiple PDF documents into one
document.
Use the new IsPDFObject function for validation.
For more information, see CFML Reference.
The page attribute changed to pages: This applies to both the cfpdf and cfpdfparam
tags.

Page 4 of 24

Feature/Tag

Description
The TableOfContents and DocumentText DDX elements are now supported by the
processddx action.
Instead of sending a variable through “#name#”, you can use the variable name itself.
The old syntax was:
<cfpdf action=”read” source=”myPDF.pdf” name=”myMPDF”>
<cfpdf action=”getInfo” source=”#myPDF#” name=”myInfo”>

The new syntax is:
<cfpdf action=”read” source=”myPDF.pdf” name=”myMPDF”>
<cfpdf action=”getInfo” source=”myPDF” name=”myInfo”>

For more information, see the CFML Reference.
Specifying the name or the destination attribute for cfpdf actions is no longer
required. The destination attribute is required for cfpdf action=”write” only.
The name attribute is required for the getInfo, processddx, and read actions only.
For more information, see the CFML Reference.
You can specify multiple page ranges in the pages attribute of thumbnail action; for
example, you can specify <cfpdf action="thumbnail" pages="1,3-4,7-11"...>
For more information, see the CFML Reference.
The default encryption for the cfpdf action="protect" is RC4_128. Before Beta 2,
the default encryption was RC4_40.
For more information, see the CFML Reference.
The cfpdf action="merge" takes a new attribute called stopOnError. The default
value is yes. If the value is set to yes, ColdFusion ignores all the files in a directory
that are not PDF files. Set it to No/False if you want to merge all files in a directory
that has some non-PDF files. No exception is generated if an invalid PDF file is
encountered.
For more information, see the CFML Reference.
The IsDDX and IsPDFFile functions have been added. For more information, see the
CFML Reference.
The processddx action returns a reason if the process fails. For more information, see
the CFML Reference.
The DDX element uses a new schema:
<?xml version="1.0" encoding="UTF-8"?>
<DDX xmlns="http://ns.adobe.com/DDX/1.0/" xmlns:xsi="http://www.w3.org/2001/
XMLSchema-instance" xsi:schemaLocation="http://ns.adobe.com/DDX/1.0/
coldfusion_ddx.xsd">

For more information, see the CFML Reference.
The default value of the stopOnError attribute of the cfpdf tag has been changed to
false.

You can use the Duplicate function to create a clone of a PDF document in memory.
You use the read action of the cfpdf tag to generate a PDF variable, and then you
use the Duplicate function to create versions of it.
Ability to manipulate existing
PDF forms by using the new
cfpdfform, cfpdfformparam, and
cfpdfsubform tags

The new cfpdfform tag lets you manipulate existing Acrobat forms (PDF forms
created with Adobe Acrobat 6.0 or earlier) and LiveCycle forms (PDF forms created
with Adobe LiveCycle Designer).
Use the cfpdfformparam tag to populate interactive fields in a PDF form.
Use the cfpdfsubform tag to populate a PDF subform in the cfpdfform tag.
For more information, see CFML Reference.
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Feature/Tag

Description
The cfpdfform tag has a new overwritedata attribute.
The datafile attribute of the cfpdfform tag has been renamed xmldata. When
action="read" the xmldata attribute value can only be a variable name.

Ability to create bookmarks by
using the cfdocument and
cfdocumentsection tags

The cfdocument tag now supports bookmarks with the bookmark attribute.
In addition, you can embed existing PDF forms using the new cfpdfform tags in the
cfdocument tag. For more information, see CFML Reference.

cfprint

The new cfprint tag lets you collate, print, and finish PDF documents. Use this tag
to generate automated batch printing jobs.
For more information, see CFML Reference.
The number of attributes have been greatly reduced and simplified for the cfprint
tag. For more information, see CFML Reference.
The orientation attribute has been removed from the cfprint tag.
Use the new GetPrinterInfo function to determine which printer attributes are valid
for a specified printer. For more information, see the CFML Reference.
You can specify multiple page ranges for the pages attribute; for example, you can
specify pages="1,3-4,7-11".
There is a new GetPrinterInfo function.

Flash Media Server event
gateway

The FMS event gateway lets you modify data through the ColdFusion application or
the Flash client, and reflect the change in the Flash Media Server shared object. The
FMS event gateway listens to the shared object, and notifies ColdFusion when other
clients modify shared objects. The FMS event gateway also lets ColdFusion modify
shared objects.

Flex integration enhancements

The following enhancements have been made to ColdFusion/Flex integration:
• CFML applications can notify a Flex destination of changes in the data being
managed by the destination.
• CFML Assemblers can return a ColdFusion query object directly from the fill
function without converting each row in to a value object (CFC).
• CFML Assemblers can use structures instead of CFC's to represent data. The
structure can contain type information which will be used as the ActionScript type
when sent to the Flex application.
• CFML applications can notify a Flex destination of changes in the data being
managed by the destination via an event gateway. To use this feature, you must
have the Beta 1 release of Borneo.
• You can install LiveCycle Data Services as part of the Scorpio install.
• You can run LiveCycle Data Services on the ColdFusion server.
Scorpio includes LiveCycle Data Services ES.
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Feature/Tag

Description

Ability to interact with the
Microsoft Exchange mail
server through the cfexchange
tags

You can now use ColdFusion tags to interact with the Microsoft Exchange server.
The Exchange interaction features include the following tags:
• cfexchangeconnection -- Opens or closes a persistent connection with the
Exchange server. You can use this connection in the other tags that interact with
the server. You can also open temporary connections that last for the duration of a
single tag by specifying connection attributes in other ColdFusion Exchange tags.
• cfexchangecalendar -- Gets, creates, deletes, modifies, or responds to calendar
events and gets calendar event attachments.
• cfexchangecontact -- Gets, creates, deletes, or modifies contacts and gets contact
attachments.
• cfexchangemail -- Gets mail messages and attachments, deletes messages, and
sets message properties. (Use the cfmail tag to create, reply to, and forward email messages.)
• cfexchangetask -- Gets, creates, deletes, or modifies a user task, and gets task
attachments.
• cfexchangefilter -- Specifies the filter conditions, such as subject or time sent, to
select the entries to get. Used only as a child tag of the cfexchangemail,
cfexchangecalendar, cfexchangetask, or cfexchangecontact tag get operations.
For more information, see ColdFusion Developer’s Guide and CFML Reference.
The cfexchangeconnection tag has the following new attributes.
• formbasedauthentication
• ExchangeServerLanguage

Ability to create and manipulate images with the cfimage
tag and associated image functions

You can create and manipulate ColdFusion images by using the cfimage tag or the
ImageNew function. The cfimage tag provides shortcuts to the most common image
actions, including reading, writing, resizing, rotating, and converting images. You
can also create captcha images.
You can use image manipulation functions to perform sophisticated image
manipulation operations.
For more information, see the CFML Reference.
The following two functions check server image compatibility to determine the
image formats that you can read and write:
•
•

GetReadableImageFormats
GetWriteableImageFormats

For more information, see CFML Reference.
CAPTCHA: The cfimage tag no longer generates Base64 images by default. This
means that you can write CAPTCHA images directly to the browser, even for Internet Explorer. You no longer have to write the CAPTCHA images to files before displaying them in an IE browser.
IsImageFile function: The new IsImageFile function lets you verify that an image file
is a valid image. You no longer have to use the <cftry> and <cfcatch> statements to
check for valid images uploaded to the server or extracted from a database.
ImageAddBorder function: The thickness parameter is now required.
ImageRead function: The syntax for the ImageRead function has changed. The new
syntax is: ImageRead("pathname")
for example:
<cfset myImage=ImageRead("images/aiden01.jpg")>
<cfimage action="writeToBrowser" source="#myImage#">

The ImageGetEXIFMetaData and ImageGetIPTCMetaData functions no longer accept a
structure as one of the parameters.
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Feature/Tag

Description
Image quality: The default image quality for the cfimage action="resize" tag and for
the ImageResize and ImageScaleToFit functions is greatly improved from the Beta 1
version of ColdFusion. Now, they use the highestQuality (lanczos) interpolation
method to resample images. For a complete list of interpolation methods and their
named equivalents, see the CFML Reference.
Note: For resize operation of 8-bit grayscale images, the supported interpolation
algorithms are: nearest, bilinear, bicubic, highestQuality, highQuality, mediumQuality, highestPerformance, highPerformance, mediumPerformance.
You must specify both dimensions in the ImageScaleToFit function. In addition, the
ImageScaleToFit function now has a fitsize argument.
The ImageResize function has a new blurFactor attribute. The value range is 1-10.
The higher the value, the more blurred the image is (and the more time it takes to
process the image)
Now, you can use the cfimage tag or the ImageWrite function to write GIF images on
the Mac. For a list of standard image formats supported by ColdFusion, see the
cfimage tag in the CFML Reference.
The value of the fonts attribute of the cfimage tag can now be a comma-delimited list
of fonts.
The ImageNew function has the following new attributes:
• canvasColor
• bgColor

Ability to zip and unzip files and
manipulate ZIP and JAR files
by using the cfzip and cfzipparam tags

Two new tags, cfzip and cfzipparam, let you manipulate ZIP and JAR files.
For more information, see CFML Reference.

Administration and Configuration
Server Monitor

The Server Monitor is an Adobe® Flash® application that lets you keep track of activities on a ColdFusion Server. You can identify information about the server, including
requests, queries, memory usage, and errors. You can start and stop collecting
server information and take snapshots of the server.

Multiserver Monitor

The Multiserver Monitor is an Adobe® Flash® application that lets you keep track of
the status of several ColdFusion Servers.

Ability to tune request performance in the ColdFusion
Administrator

In the ColdFusion Administrator, the Request Tuning page lets you specify:
• The maximum number of simultaneous requests by type, including Template
requests, Flash Remoting requests, Web Service requests, and CFC function
requests
• The maximum number of simultaneous report threads and threads available for the
cfthread tag
• When to timeout requests waiting in the queue and the page to display when a
request times out
• The maximum number of running and queued JRun requests
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Ability to disable creation of
Java objects

In the ColdFusion Administrator, on the Settings page, use the Disable Creation Of
ColdFusion Java Objects option to disable the ability for ColdFusion code to create
Java object that are part of the ColdFusion package. This prevents non-authenticated CFML templates from reading or modifying administration and configuration
information for this server.

Per application settings

You can set the following on a per-application basis:
• Mappings
• Custom tag paths
For more information, in the ColdFusion Administrator, select Server > Settings, and
then click Help. Click the Setting per application settings link.

RDS sandbox support

You can enable RDS globally or by user.
For more information, in the ColdFusion Administrator, select Security > RDS, and
then click Help.

User-based Administrator
access

ColdFusion Administrator lets you specify permissions by user. The roles assigned to
a user determine which pages in the ColdFusion Administrator and which functions
in the Administrator API a user can access. To specify access for a user, in the ColdFusion Administrator, select Security > User Manager.

CFC type checking

The ColdFusion Administrator now lets you disable CFC type checking. This lets you
simulate duck typing in CFCs.
To disable type checking, in the ColdFusion Administrator, select Server Settings >
Settings and then enable the Disable CFC Type Check option.

Debugging
Scorpio includes a ColdFusion
line debugger

The ColdFusion line debugger is an Eclipse plugin. You download the .ZIP file from
the Adobe Prerelease site.
Although the "How to Use the ColdFusion Debugger" demo illustrates stepping
through code by using the Step In, it is preferable to use the Step Over button in the
example.
For more information, view the “Preparing to Use the ColdFusion Debugger” and
“How to Use the ColdFusion Line Debugger” demos. Also, see ColdFusion
Developer’s Guide.

Language Enhancements
Multithreaded processing

The new cfthread tag lets you create, end, join together, or temporarily suspend processing ColdFusion threads. Threads are independent streams of execution, and
multiple threads on a page can execute simultaneously and asynchronously. Threads
can continue processing after the page-level code completes.
The new Sleep function temporarily suspends processing of a ColdFusion thread
that was created by the new cfthread tag. It can also be used to suspend processing
of a CFML page that does not use threads.
A new lock scope attribute value, Request, has been added to support locking
request-level code to enable you to prevent contention between threads on a page
for Application or Request scope data that is shared among the threads.
In Beta 1 a Name field was added to the thread metadata structure.
For more information, see ColdFusion Developer’s Guide and cfthread and Sleep in
CFML Reference.
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argumentsCollecton attribute

You can now specify an argumentsCollection attribute in most tags to specify the
tag's attributes in a single structure. The attribute must be a structure containing all
the tag's attributes as name value pairs. If you use the argumentsCollection attribute,
you cannot use any other attributes directly in the tag.
You cannot use the argumentsCollection attribute in the following tags. You can use
it in all other tags.
cfargument, cfbreak, cfcase
cfcatch, cfcomponent, cfdefaultcase
cfelse, cfelseif, cffunction
cfif, cfimport, cfinterface
cflogout, cflogin, cfloginuser
cfloop, cfparam, cfprocessingdirective
cfproperty, cfrethrow, cfreturn
cfset, cfsilent, cfswitch, cftry

Note: In Alpha 2, this attribute was named arguments.
The argumentsCollecton attribute has been renamed attributeCollection.
CFC interfaces

The new cfinterface tag lets you create object-oriented interface definitions. The
cfinterface tag can contain
only cffunction tags and their child cfargument tags; these tags define the signatures of the functions that make up the interface, and not the function implementations. You define the interface in a CFC file that has the cfinterface tag as its only
top-level ColdFusion tag.
You implement the interface in a ColdFusion component (CFC) that specifies the
new implements attribute. Any CFC that implements the interface must implement
each of the interface's functions as specified by the interface. A single CFC can
implement multiple interfaces.
The new IsInstanceOf function returns true if a ColdFusion object is an instance of a
ColdFusion interface, a CFC, or a Java class, or is an object that extends the
specified interface, component, or class.
To get metadata for a ColdFusion interface,there is a new method
GetComponentMetaData that accepts a component or interface name, and returns
metadata.
You can now duplicate a CFC with the Duplicate function.

CFC support for an onMissingMethod function

Page 10 of 24

CFCs support an onMissingMethod function, which lets you handle calls to methods
that are not implemented in the CFC, in the CFC itself instead of in the calling code.
To use this feature, you define an onMissingMethod function in the cfcomponent tag
body. If an application calls a method name in the CFC that is not defined, ColdFusion calls the onMissingMethod function and passes it the requested method’s name
and arguments. If you do not define an onMissingMethod function, a call to a method
name that is not defined in the CFC causes ColdFusion to throw an error that must
be handled in the calling code.

Application.cfc support for an
onMissingTemplate function

The Application.cfc page can include an onMissingTemplate function, which will be
invoked when ColdFusion encounters a file not found condition. When a ColdFusion
page requests a page that cannot be found, ColdFusion searches for the Application.cfc file starting in the physical directory represented by the requested URI, and
proceeds up the parent directories.
The onMissingTemplate function must have the following format:
<cffunction name="onMissingTemplate" returnType="boolean">
<cfargument type="String" name="targetPage" required="true"/>
<!--- Error handling code, such as cfoutput tags, goes here. --->
<cfreturn BooleanValue />
</cffunction>
The onMissingTemplate function must return true to indicate that the event has been

processed or return false to indicate that the event has not been processed. If
nothing is returned, its assumed to be true. If the function returns false, ColdFusion
invokes the standard error handler. If an error occurs within the onMissingTemplate
function, the error handler is not invoked
If the onMissingTemplate function is invoked, the onApplicationStart,
onSessionStart, onRequestStart, onRequest, and onRequestEnd handlers are not
invoked, and processing of the request terminates when the onMissingTemplate
handler returns.
Application.cfc welcomefilelist variable

CFC serialization

You can now specify a welcomefilelist variable in the Application.cfc containing a
comma delimited list of file names to tell ColdFusion not to call the onMissingTemplate method if any of the files on the list are not found. Use this variable to prevent
ColdFusion from invoking the onMissingTemplate handler if the following are true:
• The user is trying to browse a directory and you want to support directory browsing
• Your web.xml uses a welcome file list and searches for files on the list when the
user specifies only a directory path.
You specify this variable only if the Application.cfc also specifies an
onMissingTemplate handler. It should contain the same list of files as your web.xml
welcome file list.
Lets you use J2EE session replication in a cluster and have access to the CFCs in
session data across all the machines in a cluster. This feature supports CF variables,
including structures, in a replicated session scope. (Arrays are not supported in this
release.)
Also lets you preserve and access data in a CFC in the case of session failover.
ColdFusion structures stored inside the session scope are available in the session
scope, even after failover. For example, if you are running multiple ColdFusion
instances to balance server load, you can store useful data, including CFCs, inside
the session so that you can access the data across all the pages that are served in
that session.
The following example illustrates how to store a CFC in the session scope. Even if a
client is switched to a different instance of the application server, the CFC data is still
in the session scope.
<cfset cfccomponent = CreateObject("component", "CFIDE.adminapi.datasource")>
<cfset session.datasourcecomponent = cfccomponent>

After failover, you can then access and call methods in the CFC as follows:
<cfset check = session.datasourcecomponent.verifyDSN("testdsn")>

Implicit creation of arrays and
structures

You can now create arrays and structures implicitly in assignment statements without using the ArrayNew or Structnew functions.
To create a structure, delimit the structure contents in curly braces ({}). Inside the
braces, create each key-value pair using keyName="value" (or
keyName=expression) and separate the entries with commas, as in the following
example:
<cfset MyStruct={Mykey1="Myvalue1", Mykey2=MyString1 & " is a string"}>

To create an array, delimit the array contents in square brackets ([]). inside the
brackets, and separate array elements with commas, as in the following example:
<cfset MyArray=[MyStruct, "Hello", 2, MyString2 & "is another string", i++]>
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The following rules apply to implicit array and structure creation:
• You can also use implicit array and structure creation in CFScript.
• You cannot create nested arrays or structures in a single expression. For example,
the following syntax is invalid:
<cfset struct1 = {key1={innerstructkey1 = "innerstructvalue1"}}>

Instead, use two statements, as follows:
<cfset innerstruct1={innerstructkey1 = "innerstructvalue1"}>
<cfset struct1={key1=innerstruct1}>

• You cannot include dots in key names when you create a structure. For example,
<cfset struct1={key1.key2="value"}>

is not valid.
• You cannot assign an implicitly created structure to an array element. For example,
a[1]={key1="value1"} does not currently work.
New file manipulation functions

Several file manipulation functions have been added:
• The following functions let you read and write large files a chunk at a time, rather
than in a single operation: FileClose, FileIsEOF, FileOpen, FileRead,
FileReadBinary, FileReadLine, FileWrite, and FileWriteLine.
• The following file manipulation functions have also been added: FileCopy,
FileDelete, FileMove, FileSetAccessMode, FileSetAttribute,
FileSetLastModified, and GetFileInfo.

New login-related functions

The following functions have been added that provide information about a user's
login status:
IsUserInAnyRole - Determines if the current user is in any of the specified roles in a
list. This method checks the roles setup by the cflogin tag and by the servlet API.
GetUserRoles- Returns list of roles belonging to a user. This returns list of only
ColdFusion roles and not roles set by servlet API
IsUserLoggedIn - A convenience function, the equivalent of GetAuthUser() neq "".
For more information, see CFML Reference.

Arithmetic and string operations
Ability to use JavaScript operators

You can now use the following JavaScript operators in all CFML expressions: ++, --,
%, +=, -=, *=, /=, %=, &&, ||, !,
You can use the following operators in CFScript expressions only: ==, !=, <, <=, >,
>=

You can now use the &= operator in all CFML expressions to concatenate the string
specified to the right of operator on the end of the string variable specified in the left
side of the operator.
Arbitrary-precision decimal
arithmetic

The new PrecisionEvaluate function evaluates one or more string expressions using
arbitrary-precision (BigDecimal) arithmetic to calculate the values of arithmetic
expressions.
For more information, see CFML Reference.

Database access
Ability to turn on logging for
DataDirect data sources

The DataDirect data sources (DB2 Universal Database, Informix, MS SQL Server,
Oracle, and Sybase) include an option to turn logging on and off in the ColdFusion
Administrator.

cfdbinfo

Lets you get information about a data source.
For more information, see CFML Reference.
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cfprocparam

Lets you specify the name of parameters to stored procedures in any order using the
dbVarName attribute.

Generating reports and presentations
Report Builder enhancements

Scorpio provides several enhancements to Report Builder to make it easier to use.
Functionality includes:
• Page breaks: You can add a page break anywhere in a report except in the page
header or column header. To add a page break, click the page break button in the
Toolbox, choose Insert > Page Break, or use the right-click menu in the band where
you want to insert the break.
• Component locking: You can lock components so that they cannot be moved
within the IDE. To lock a component, select the component and click the lock icon
in the Toolbox or use the right-click menu. The status bar displays a locked status
when one or more of the selected components are locked.
• Component naming: You can name all components by using the new Name
property. The Name property is located in the Data section of the Properties panel
for the component. This functionality is required for future enhancements to
Report Builder.
• Component moving functionality is improved.
• Line sizing functionality is improved.
• Zoom functionality is improved.
• Function Editor enhancements: You can edit the function name more easily by
using the edit box at the top of the function section. You can use the Add Default
Functions button to import and use the InitializeReport, BeforeExport,
FinalizeReport functions as necessary. You can perform search and replace
actions and use the right-click menu to perform commands in the Function Editor.
You can use tag dialog boxes for any tags used in a function you are editing.

Reporting Builder enhancements

Scorpio provides several enhancements to Report Builder and the cfreport tag,
including the following:
Report Styles: In Report Builder you can create and apply Cascading Style Sheet
(CSS) definitions by using the Report Styles Editor. Report Builder lets you do the
following:
• Create styles and apply them to elements in the report.
• Export styles created in Report Builder to a CSS file. Report Builder generates the
CSS code for you. Most of the generated styles are standard CSS styles; however,
some are unique to Report Builder.
• Import a CSS file. You can import a standard CSS file, or one generated by Report
Builder, and apply it to the report. When you import a CSS file to a report, Report
Builder automatically populates the Style Name drop-down lists with the styles in
the report. This way, you can apply individual styles from the CSS file to report
elements.
See CFML Reference for a list of standard CSS styles supported by Report Builder
and styles unique to Report Builder. (If your style sheet includes unsupported styles,
ColdFusion ignores them).
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Follow these steps to define a new style in Report Builder:
1.

Choose Window > Report Styles from the menu bar. The Report Styles window
appears.

2.

Click the Add Report Style icon (the plus sign on the left). The Add Style dialog
box appears.

3.

Enter a name for the style in the Name field. Click the tabs to define the font
type, font size, color, style, transparency, and borders.

4.

(Optional) Click the Export Report Styles icon to export the style to a CSS file.

5.

(Optional) Click the Import Report Styles icon to import a CSS file from disk.

6.

Click OK to save the style.

ColdFusion support for CSS styles: ColdFusion lets you override CSS styles in
Report Builder reports and subreports at runtime. The cfreport and cfreportparam
tags now have a new attribute called style. The style attribute takes a CSS file or an
in-line style definition as its value. You can create CSS files in one of two ways: by
exporting styles via the Export Report Styles icon in Report Builder or by creating a
CSS file in any text editor. For the CSS styles to take effect; however, you must use
Report Builder to assign the style names to the elements in the report. (The exception is the default style: you can use the style attribute to define the default style in
ColdFusion and apply it to the report even if the default style is not defined in Report
Builder.) After you have assigned the style names in Report Builder, you can update
the style definitions in the CSS file at any time and apply them at runtime by using the
cfreport and cfreportparam tags. If your report contains subreports, the default style
applies to the master report and to all of the subreports. If the master report uses
CSS styles other than the default style, the CSS styles do not apply to the subreports
unless you specify them explicitly.
See CFML Reference for a list of standard CSS styles supported by Report Builder
and the styles unique to Report Builder. (If your style sheet includes unsupported
styles, ColdFusion ignores them).
The value of the value attribute of the cfreportparam tag can now be a variable.
HTML and XML Report Formats: You can export your Report Builder reports in
HTML or XML format. Follow these steps to export a report in HTML format from
Report Builder:
1.

Choose Report > Report Properties from the menu bar. The Report Properties
dialog box appears.

2.

Choose HTML or XML from the Default Output Format list.

3.

Click OK. Report Builder writes any images in the CFR file to a temporary directory so that they display in the browser.
Also, you can generate an HTML or XML report at runtime from ColdFusion by using
the new HTML and XML values of the format attribute. For example:
<cfreport template="myReport.cfr" format="HTML">
<cfreport template="myReport.cfr" format="XML">

When you export a report in HTML format, ColdFusion creates a temporary resource
directory to store any image files or other resource files in the report when it is written
to the browser. To specify when this resource directory is deleted, use the resourceTimespan attribute. The new attribute requires a time span (created using the CreateTimeSpan function) as a value. The following code deletes the resource directory
after one hour:
<cfreport template="myReport.cfr" format="HTML"
resourceTimespan=#CreateTimeSpan(0,1,0,0)#>

See CFML Reference for more information.
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Avoiding display problems in HTML reports: Unlike PDF and FlashPaper formats,
which support free-form page content, the HTML format supports relative positioning of elements on a page for a grid-based layout. ColdFusion generates a <table>
element for each report page and inserts each report element on that page inside a
<td> tag. Because a table cell can contain only one element, report elements that
overlap in the layout do not display correctly. When two elements overlap, the element behind does not appear in the exported HTML. To optimize a report for the
HTML output format, follow these guidelines:
• Minimize the number of rows and columns by aligning report elements, both on the
horizontal and the vertical axis.
• Eliminate any extra space between the elements.
• Avoid overlapping report elements.
Override queries in subreports and charts from ColdFusion: You can now override
the queries used for subreports and embedded charts using cfreportparam. This way
you can customize subreport and chart data from the CFM page without having to
change your report. (The ColdFusion query must contain at least all of the columns
included in the Report Builder query; however, the WHERE clause in the ColdFusion
query can differ.) To support this feature, the cfreportparam has the following new
attributes:
• subreport: The name of a subreport. This value must match the Name property for
the subreport defined in Report Builder.
• chart: The name of a chart contained in a report or subreport. This value must
match the Name property defined in Report Builder.
• query: A query value to pass to the specified chart or subreport.
• series: The number of the chart series for which to provide a query.
See CFML Reference for the syntax.
In Report Builder, charts and subreports now have a new property called Name. To
pass queries from the CFM page to the report, the value of the subreport or chart
attribute on the CFM page must match the Name property in the report.
Follow these steps to specify a chart or subreport name in Report Builder:
1.

Select the subreport or chart element in the report.

2.

Choose Window > Properties Inspector from the menu bar. The Properties
Inspector for the selected element appears.

3.

Under the Data heading, enter the name for the element in the Name field.
(Report Builder generates a default name.)

4.

Choose File > Save from the menu bar to save your changes.

7.0.2 Enhancements
Report Builder introduced the following features in version 7.0.2, which were
undocumented.
XHTML Text Formatting: You can specify XHTML text formatting for labels and text
boxes. This means that if the field is XHTML-compliant, Report Builder applies the
formatting to text when the report is printed. For example, if XHTML Text Formatting
is set to True, Report Builder prints the following label in bold: <b>This is label is bold</
b>. Report Builder supports the following subset of XHTML-compliant tags:
• <:b>, <strong>
• <i>, <em>
• <u>, <underline>
• <s>, <strike>
• <font color=“#HexValue” size=“1 through 7 and +/-”>
• <p>
• <br>
• <a href=“URL” anchor=“anchor name”>
• <ul>, <ol>, <li> (no optional attributes for the <ul> and <ol> tags)
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To set XHTML Text Formatting, select the label or text box in the report band and
then do one of the following:
• Choose Windows > Properties Inspector from the menu bar. The Properties
Inspector for the selected element appears. Under the Formatting heading, choose
True for XHTML Text Formatting.
• Choose Modify > Properties from the menu bar. The Properties dialog box appears.
Click the Formatting Tab and select the XHTML Formatted Text checkbox. Click
OK.
Built-in Report Builder functions: Report Builder provides three report-level built-in
functions that you can access from the Report Function Editor. The functions exist
only in Report Builder (not ColdFusion); therefore, you specify them in the report
itself, not as part of the calling page. You do not call these functions explicitly; Report
Builder calls them automatically when the report runs. The built-in functions are not
required: do not define them if you do not need them. The built-in functions are as
follows:
• InitializeReport: This function executes before the report is run. If you are calling
the report by using the cfreport tag in ColdFusion, you can use this function to
access information on the CFM page. For example, you can verify that all the
variables are initialized. You can include a cfthrow tag in the InitializeReport
function to throw an error and force the report to not run. Note that, because the
InitializeReport function executes before the report is run, you cannot use it to
access any information in the report itself, only in the CFM page that calls the
report. The following code shows an InitializeReport function that generates an
error message if the user is not logged on:
<cffunction name="InitializeReport">
<cfif not(isDefined("url.loggedin"))>
<cfthrow message="You need to be logged in to run this report.">
</cfif>
</cffunction>

• BeforeExport: This functions lets you reorder pages in your report. For example,
you can use this function to reposition a generated table of contents. To create an
automatically generated table of contents, you need to place the table of contents
element in the report footer so that it runs after the rest of the report. But, because
the element is in the report footer, Report Builder prints it at the end of the report,
by default. To print the table of contents at the beginning of the report, use the
BeforeExport function. The following code shows how to use the BeforeExport
function to reposition a generated table of contents after the report header but
before the rest of the report:
<cffunction name="BeforeExport">
<cfargument name="pagecount">
<!--- Change this structure to return the pages you need. --->
<cfset pages=StructNew()>
<!--- Set the title page as the first page. --->
<cfset pages["1"]="1">
<!--- Set the table of contents to the second page. --->
<cfset pages["2"]="#arguments.pagecount#">
<!--- Set the rest of the report to follow the table of contents. --->
<cfloop index="i" from="2" to="#arguments.pagecount - 1#">
<cfset pages["#i+1#"]="#i#">
</cfloop>
<cfreturn pages>
</cffunction>
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• FinalizeReport: This function executes after the report is run. Use it to clean up
code or send e-mail notifications, for example, or run another report after the
current report finishes. Note that if you write the report directly to the browser,
without writing it to disk or a variable, Report Builder does not display the
messages on the screen. In this case, you need to check the ColdFusion error log
to check for errors. The following code uses the FinalizeReport function to write a
line in the log file that confirms that the report finished running:
<cffunction name="finalizeReport">
<cflog text="In FinalizeReport" type="Information" thread="yes" date="yes"
time="yes" application="yes">
</cffunction>

Follow these steps to access the built-in functions in Report Builder:
1.

Choose Report > Report Functions from the menu bar. The Report Function
Editor appears.

2.

Click the Add Default Functions button (the first icon on the left). Report Builder
adds the three functions to the list on the left.

3.

Click on a function in the list to display the edit area for that function.

4.

Enter the code for the function.

5.

Click OK to save the code and return to the report.

The Justify option does not appear in the preview of the Properties dialog box or the
Style dialog box. This is a limitation of the Preview Component in the Propterties and
Style dialog boxes.
Styles are not passed from the parent report to any subreports (or subreport of subreports, etc) with the exception of the default style which will propogate down to any
reports beneath it.
Ability to create slide presentations dynamically from HTML
code on a CFM page or Adobe
Connect (SWF) files by using
the new cfpresentation, cfpresentationslide, and cfpresenter tags

The following tags let you generate Adobe Connect slide presentations. You can
write the presentation files to disk or directly to a browser. The presentation can
access live data from a database which you can use to populate charts and graphs.
The cfpresentation tag is the container for the slide presentation. The
cfpresentationslide tag creates a slide dynamically from an HTML page or SWF
file.
The cfpresenter tag describes a presenter in a slide presentation.
For more information, see CFML Reference.
The pathnames specified for the audio and video attributes of the cfpresentationslide tag must be relative to the CFM page or the web root.
The following attributes have been added to the cfpresentation tag: proxyHost, proxyPort, proxyUser, proxyPassword, authUser, authPassword, userAgent.
The following attributes have been added to the cfpresentationslide tag: authUser,
authPassword, userAgent.

The cfpresentation tag now allows common colors and web color codes. Common
colors include red, green, blue, black, yellow, magenta, pink, orange, cyan, gray,
lightgray, and darkgray. Web colors are in the format #FFFFFF.
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OEM support
JBOSS support

Scorpio supports JBOSS with the following specifications:
• JBOSS 4.0.3SP1 (inherently uses Tomcat 5.5 Server Container)
• Sun JRE 1.4.2_09 and Sun JRE 1.5
• Host OS - Windows 2003 Server SP1 and RedHat Linux 4 AS

JDK 1.6 support

Scorpio supports JDK 1.6 as the runtime environment. By default, Scorpio installs
and runs on JDK 1.6.

Support for the latest JDBC
drivers and Database support

Scorpio supports the DataDirect Version 3.6 JDBC drivers.

Verity

The Verity Binaries are updated to V5.5.0 Service Pack 2 Patch 05 on all platforms.

Security

ColdFusion now includes the RSA JSafe encryption, which provides FIPs certified
encryption, on Enterprise edition.
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What's Different in this Release
In addition to the new features listed in the previous section, the following changes have been made in Scorpio
■

When deploying J2EE ColdFusion on WebSphere, the Application Name has been changed from MacroMedia
ColdFusion MX.ear to Adobe Scorpio.ear.

■

The Apache FTP library (provided by the Apache Commons commons-net library) bundled with ColdFusion has
been upgraded from version 1.2.2 to version 1.4.0.

■

The version of Log4J that is bundled with ColdFusion has been upgraded from version 1.1.3 to version 1.2.12.
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The following table lists changes to existing ColdFusion tags and functionality:

Feature/Tag
When deploying J2EE ColdFusion on WebSphere, the
Application Name has been
changed from Macromedia
ColdFusion MX.ear to Adobe
Scorpio

Description
For example,
/opt/WebSphere/AppServer/installedApps/cfqa40/MacromediaColdFusionMX.ear/

is now:
/opt/WebSphere/AppServer/installedApps/cfqa40/AdobeScropio.ear/

Scorpio supports the DataDirect 3.6 drivers

Scorpio supports the following:
• Auto-generated key retrieval - return a list of the ids of the inserted data
• Transaction savepoints
• The ColdFusion Administrator enables logging of database activity
• DataDirect drivers map all new data types to JDBC 3.0 types, all of which
ColdFusion supports
• Multiple result sets can now be open simultaneously
• Oracle 10g (R2)
• SQL Server 2005
- New varchar(max), nvarchar(max), varbinary(max), and xml data types
- Support for named parameters
- New XML data type supports native XML handling and XQuery syntax
- Optional OUTPUT clause to insert, update and delete statements can return a
result set
• Sybase ASE 15
- Support for new bigint, unsigned bigint, unsigned int, unsigned smallint, and
unitext data types
• Informix 10
• DB2 UDB 8.2
• DB2 UDB for OS/390 v6.1
• OEM PostgreSQL JDBC 3.0 Type IV driver to ship with Scorpio supports
Postgres 8.1
- Supports transactions and savepoints

Flash forms

Flash Form MXML keyword restrictions have been removed.

Event Gateways

The limis for Event Gateways have been changed in the Developer edition, as follows:.
• Event gateway are now supported
• The limit on Buddies/SMS client has been increased from 1 to 3.

JNDI port

Scorpio uses 2930 as the JNDI port, so that it can coexist with ColdFusion MX 7.

Administrator API

Administrator API cfide.adminapi.runtime.cleartrustedcache()function now takes an
optional templateList argument, which is comma separated list containing the template paths to be deleted from trusted cache. The template paths should be full physical paths to the templates.
If any of the templates in the list do not exist, ColdFusion throws an error with a
cumulative list of the non-existent templates and clears the template cache for rest of
templates.
The following example show how to use this function:
cfide.adminapi.runtime.clearTrustedCache(templateList="c:/cfmx/wwwroot/
example.cfm,c:/cfmx/wwwroot/example2.cfm");
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Feature/Tag

Description

cfdirectory

The cfdirectory tag now includes following attributes:
listInfo = " name|all"
type = "file|dir|all"
The listinfo attribute lets you limit the returned query to include only the name of

the files. It can also improve performance significantly.
The type attribute lets you restrict the returned list to include only files or directories.
The default action is to include both.
cfdocument, cfdocumentsection, cfdocumentitem

The cfdocumentsection tag now includes the following attributes:
name = "bookmark name"

For more information, see CFML Reference.
Two new scope variables have been added: totalSectionPageCount and currentSectionPageNumber.
If you do not specify the mimeType attribute for the cfdocument, cfdocumentitem, or
cfdocumentsection tag, ColdFusion determines the MIME type based on the filename
of the source.
The following attributes have been added to the cfdocument tag: proxyHost, proxyPort, proxyUser, proxyPassword, authUser, authPassword, userAgent.
The following attributes have been added to the cfdocumentsection tag: authUser,
authPassword, userAgent.
The following attribute was added to the cfdocument tag in Alpha 1, but was undocumented: saveAsName, which provides the option to supply a PDF filename in the
SaveAs dialog when a user saves the output from the browser (before this attribute
was added, ColdFusion supplied the CFM page name).
cfdump

The cfdump tag lets you specify which columns of a query to display, which keys and
how many keys of a structure to display, and whether or not to include UDFs. You
can send the output of the cfdump tag to the console, the browser, or a file.
For more information, see CFML Reference.

cfexchangeconnection

Added getsubfolders action. This action gets a query with the names, paths and
sizes of subfolders of a folder and can optionally get information about all lower level
subfolders.
For more information, see CFML Reference.

cfexchange* tags

The cfexchangecalendar, cfechangemessage, and cfexchangetask tags now return an
additional, HTMLmessage column in the query attribute variable, and the cfexchangecontact tag returns an HTMLDescription column in the query attribute variable. These columns contain an HTML-formatted version of the Message or
Description field text.

cfform

If you specify the scriptsrc attribute in the cfform tag and are using Flash forms, you
must include the CF_RunActiveContent.js file in the directory you specified in the
scriptsrc attribute. You can copy this file from wwwroot/CFIDE/scripts/
CF_RunActiveContent.js.".
You only need it if:
• You override the default
• You are using Flash

cfftp - secure FTP support

The cfftp tag now includes the following attributes:
key = "private_key"
passphrase = "passphrase"
fingerprint = "ssh-dss.ssh-rsa"
secure = "yes|no "
For more information, see CFML Reference.
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Feature/Tag

Description

cfftp

The cfftp tag has new values for the action attribute: allo, site, acct, quote; a new
buffersize attribute; and a new actionparam attribute.

cfargument and cffunction

The cffunction tag returnType attribute and cfargument tag type attribute now
accept the value component to identify that the argument type or function return type
is a ColdFusion component. In other words, you can now specify component instead
of WEB-INF.cftags.component as these attributes' values. As in previous releases,
you can specify that the argument or return type is a specific component by using the
component name.

cffunction

The cffunction tag has a new returnformat attribute that controls the format of data
that is returned to a remote caller such as a web service or an AJAX page.

cfhttp

The cfhttp tag has the following new attributes:
ClientCert - full path to a PKCS12 format file containing the client certificate for the
request
ClientCertPassword - the password used to decrypt the client certificate.

cfinvoke

The cfinvoke tag now has a refreshWSDL attribute, which lets you reload a WSDL and
regenerate all of the artifacts used to invoke this web service. This can be used for
development when the WSDL for a service is changing.

cfldap

The cfldap tag's returnAsBinary attribute now accepts a comma as the delimiter in a
list, for example:
<cfldap returnAsBinary="objectGUID ,objectSID">.

cflocation

The cflocation tag has a new statusCode attribute that allows you to specify a redirection status code in the range between 300 and 307. The default value of 302,
which is the redirection code used in previous versions of ColdFusion. For details on
the status codes, see HTTP RFC 2616 - section 10.3 Redirection 3xx.

Locale-specific functions have
new locale attribute

The following functions now support a locale parameter, which lets you the specified
locale instead of the current locale of the page.
• DayOfWeekAsString
• LSCurrencyFormat
• LSDateFormat
• LSEuroCurrencyFormat
• LSIsCurrency
• LSIsDate
• LSIsNumeric
• LSNumberFormat
• LSParseCurrency
• LSParseDateTime
• LSParseEuroCurrency
• LSParseNumber
• MonthAsString
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Feature/Tag

Description

cfloop enhancements

The following enhancements have been made to the cfloop tag:
You can use the cfloop tag with the file attribute to read a file in a loop. You can
read one line at a time, by specifying the index="line" attribute without a from or to
attribute, or a specified number of characters at a time, as shown in the following
example:
<cfloop file="c:\temp\myfile.txt" index="line">
<cfoutput>#line#</cfoutput>
</cfloop>
<cfloop file="c:\temp\myfile.txt" index="line" from="5" to="10">
<cfoutput>#line#</cfoutput>
</cfloop>
A new array attribute lets you iterate over entries in an array, as shown in the

following example:
<cfset x = ["mars","earth", "venus", "jupiter"]>
<cfloop
array=#x# index="name">
<cfoutput>#name#</cfoutput><br>
</cfloop>

Ability to cache query objects
when you use the cfqueryparam
tag with the cfquery tag.

You can now cache query objects when you use the cfqueryparam tag in a query, as
the following example shows:

cfreport

The cfreport tag's format attribute now allows XML and HTML values. The Report
Builder also supports these output formats. The cfreport tag has two new attributes:
• style: used for overriding CSS styles in Report Builder reports
• resourceTimespan: used when exporting reports in HTML format
For more information, see CFML Reference.

cfreportparam

The cfreportparam tag has four new attributes to support overriding data in Report
Builder subreports and charts from the CFM page:

<cfset CourseID=1>
<cfquery name="getCourse1"
datasource="courses"
cachedafter="1-1-99">
select * from Courses
where ID = <cfqueryparam value = "#CourseID#"
CFSQLType = "CF_SQL_INTEGER">
</cfquery>

•
•
•
•

chart
query
series
subreport
The new style attribute overrides CSS styles defined in Report Builder subreports.

For more information, see CFML Reference.
cfschedule

The cfschedule tag's action attribute now allows pause and resume values. The
ColdFusion Administrator also supports this functionality on the Scheduled Tasks
page.

Ability to cache the results of a
stored procedure using the
cfstoredproc tag

The cfstoredproc tag now supports the cachedwithin and cachedafter attributes, like
the cfquery tag.

sendStringParametersAsUnicode

The connect string sendStringParametersAsUnicode=true is no longer supported in
Scorpio for SQL Server and Sybase data sources Instead, you can enable the String
Format option for SQL Server data sources in the ColdFusion Administrator.

Updated Verity binaries

Scorpio includes Verity V5.5.0 Service Pack 2 Patch 05. You can now connect to a
Verity K2 installation with authentication enabled. To specify the username and
password, in the ColdFusion Administrator, select Data & Services > Verity K2
Server.
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